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1 Uvod

1.1 Vizuelizacija

Od svih ¢ula koje poseduje, ovek se oduvek najvise oslanjao na ¢ulo vida. Prvi utisak se skoro uvek dovodi
u vezu sa izgledom. Nebitno da li je u pitanju kuéa, park, novi automobil, neki novi uredaj, kuéni ljubimac,
biljka u dvoristu ili osoba, ono §to se vidi je u dosta slu¢ajeva presudno da li ée se nastaviti interesovanje za
objekat ili osobu, pa ¢ak moZzda i biti presudno za neku kona¢nu odluku.

Iz tog razloga se, u danasnje vreme, posebna paznja poklanja slikama. Zbog toga je vazno da sadrzaj i izgled
slike bude dobar. Taj izgled se ne moze posti¢i samo dobrom kamerom ili fotoaparatom, nego se pribegava
kompjuterskoj obradi i programima namenjenim za to.

Razvojem tehnologije, razvijali su se i programi za obradu digitalnih fotografija. Danas je moguce vrlo lako

pristupiti internet stranici ili programu sa gotovim alatima za obradu slika.

1.2 Cilj i namena rada

Pre svega, ovaj rad je namenjen ucenicima koji bi Zeleli da znaju viSe o ovim programima, ali i nastavnicima
kojima ¢e pomo¢i u nastavi informatike. Takode, je namenjen i svima kojima je potrebna pomo¢ u snalazenju

u radu sa ovim programima.

1.3 Struktura rada

Rad se sastoji iz dva dela:

1. Uvodni deo rada bavi se teorijskim pitanjima koja su potrebna za rad sa slikama. On sluzi kao priprema

za drugi deo, ali je neophodan za razumevanje nacina na koji rac¢unarska grafika funkcionise.

2. Ovaj deo rada bavi se programima za obradu slika i uz njega je izuzetno vazan prakti¢an rad. Ovo je

suStina rada. U njemu su objasnjene funkcije i alati, na¢ini na koji se koriste i podesavanja koja sadrze.

1.4 Informatika i raCunarstvo u osnovnoj skoli

U skladu sa tehnicko-tehnoloskim razvojem pojavila se potreba za informatickim oblikom pismenosti. In-
formatika i racunarstvo u osnovnoj Skoli je izborni predmet. Ucenici se ankteraju na pocetku svake §kolske
godine od petog do osmog razreda i pohadaju, jedan ¢as nedeljno, do kraja tekucée 8kolske godine. Ocena iz
ovog predmeta ne ulazi u prosek ocena ucenika. Za oblast ra¢unarske grafike je predvideno deset ¢asova u toku

Sestog razreda, a za obradu slika Cetiri od tih deset ¢asova.



2 Tipovi formata slika

2.1 Predstavljanje grafike u rac¢unaru

Postoje dva osnovna nacina za predstavljanje grafike u rac¢unaru:

e vektorski;

e rasterski.

Kod programa koji predstavljaju slike vektorski (draw programs), pamte se linije od kojih je slika sastavljena
i njihove osobine (debljina, vrsta linija, boja), a kod zatvorenih kontura i boja unutrasnjosti konture. Na primer,
ako je na slici samo kurg potrebno je zapamtiti: tip objekta (krug), koordinate njegovog centra, polupre¢nik i
boju kojom je popunjen. Jasno je da koli¢ina podataka koju treba zapamtiti zavisi samo od slozenosti slike [1].

Kod programa koji predstavljaju slike rasterski (paint programs), povrsina slike je podeljena u mrezu kva-
drati¢a linijama paralelnim sa koordinatnim osama. Ovi kvadratiéi zovu se pikseli (piksel - od picture elements).
Svaki piksel ima svoje osobine, a to su: njegovo mesto, boja i intenzitet boje (svetla). Na primer, ako je na slici
samo krug, potrebno je zapamtiti za svaku tacku na kruznici, u krugu ili izvan njega, njenu boju i intenzitet
boje. Program ne vodi nikakvu evidenciju o medusobnim vezama tacaka (kao kod vektorskog predstavljanja)
nego svaku tacku posmatra nezavisno. Zauzeée memorije za sliku ne zavisi od kompleksnosti slike, nego samo
od broja piksela na koji je podeljena povrsina i broja boja koje su na raspolaganju, tj. sve slike iste veli¢ine
zauzimaju jednaku memoriju.

Broj podela po horizontali i vertikali izrazava rezoluciju i jasno je da ¢e
kvalitet slike biti bolji §to je rezolucija veéa. Rezolucija slike se izrazava u

broju tacaka po in¢u - dpi (dot per inch, 1 in = 2,54 cm). Na slici 1 prikazana

je rasterska slika kruga na ekranu, u nizoj rezoluciji (levo) i viSoj (desno).

Mreza na slici 1 - desno ima dva puta viSe podela po svakoj osi, §to znaci da

Slika 1: Rezolucija

ima Cetiri puta viSe piksela. S obzirom na to da su pikseli manje veli¢ine, slika
bolje predstavlja krug. Na isti na¢in se na ekranu predstavljaju i slova.

Svaki piksel slike ¢uva se u memoriji ra¢unara posebno i pridruzuje mu se jedan, dva, tri ili ¢etiri bajta, u
zavisnosti od toga sa koliko boja se radi. Ako je pikselu pridruzen samo jedan bajt njime moze da se predstavi
samo 256 boja. Boja koja se ne nalazi u ovih 256 kombinacija zamenjuje se bojom koja joj je najbliza. Ako su
pikselu pridruzena dva bajta (High Color - 16 bita) njime moZe da se predstavi 65 536 boja. Ako su pikselu
pridruZena tri bajta (True Color - 24 bita) njime moZe da se predstavi priblizno 16,7 miliona boja. Ako su
pikselu pridruZena cetiri bajta (True Color - 32 bita) njime moZe da se predstavi priblizno 4,3 milijarde boja.
Ovakva predstava slike u memoriji ra¢unara zove se bitmapa. Zauzeée memorije u bajtovima za sliku je jednako
broju piksela pomnozeno sa brojem bajta po pikselu.

Posto se podaci o osobinama elementa (piksela) pamte za sve tacke, koli¢ina podataka koji se pamte ne zavisi
od slozenosti crteza, nego samo od broja piksela (tacka slike) i broja boja koje moZe imati svaka tacka.

S obzirom na to da svako povecanje rezolucije slike i/ili njenih dimenzija zna¢ajno povecéava koli¢inu memorije

potrebne za njeno ¢uvanje u memoriji, razvijene su razli¢ite tehnike ¢uvanja kod kojih se odredenim sistemom



Stedi memorija potrebna za ¢uvanje slike. Tako postoje razli¢iti formati za ¢uvanje slika, pri ¢emu se, u slucaju
kompresije zbog ustede prostora, slika moze sac¢uvati bez gubitaka ili sa gubicima.

Treba uociti da rasterski - bitmapirani programi imaju manju preciznost od vektorskih. Naime, dok se
kod vektorskog crtanja svaka tacka na linijama crteza zamenjuje se, priblizno, pikselom koji najvise odgovara
poloZaju te tacke. Zbog toga se vektorski programi koriste za primene gde je vaZna preciznost (na primer,
tehnicko crtanje), a rasterski programi za primene gde je vaZniji prirodni utisak (gotografije, slike za reklame
itd.).

Kod vektorskih programa graficki objekti se modifikuju jednsotavno promenom odgovaraju¢eg parametra u
zapisu objekta. Ako se Zeli uvecanje ili umanjenje objekta, racunar ¢e jednostavno izra¢unati nove vrednosti
parametara i zatim nacrtati sliku u skladu sa novim vrednostima. Pri tome ni jedan deo slike i ni§ta od
informacija o slici nije o§teceno ili nepovratno izgubljeno.

Kod rasterskih programa javljaju se problemi kako pri povec¢avanju ili smanjenju slike, tako i pri njenoj
pripremi za $tampanje. S obzirom na to da je slika formirana od tacaka (piksela), uveéanje ima smisla jedino
ako se obavlja sa celobrojnim faktorom (2x, 3x itd). Medutim, u tom sluc¢aju odbija se slika kod koje je svaka
taCka zamenjena sa Ceitri, devet, Sesnaest itd. tacaka, i koja je izrazito zrnasta. Kod ovakve slike zaobljene
linije bi¢e nazubljene a detalji loSe prikazani. Ako se slika, nastala u rasterskom programu, smanji na 50%
izvorne veliCine, iz slike treba izbaciti svaku drugu tacku po svakoj osi. To znaéi da je, posle smanjenja, u slici
ostala samo jedna Cetvrtina izvornih tacaka, a da je tri ¢etvrtine (75%) izvornih tacaka nepovratno izgubljeno.
To se najbolje vidi ako se umanjena slika ponovo uveca na prvobitnu veli¢inu. Drugi problem je kada se slika
Salje na Stampanje. Kako rezolucija Stampaca dovodi do smanjenja slike i obrnuto. Ako §tampa¢ nema jednaku
rezoluciju po obe ose pojavice se i izduzivanje slike po jednoj ili drugoj osi.

Oba nacina predstavljanja slike u programu imaju i druge prednosti i nedostatke. Jedna od takvih prednosti
rasterskih programa je velika realisti¢nost bitmapirane slike u odnosu na nedostatak realizma kod nacrtanih
objekata.

2.2 Osnovni formati za ¢uvanje crteza i slika

Kod programa za rad sa crtezima, crtez se nalazi u ra¢unaru u vektorskom obliku. Kada se u programu radi
sa slikom, ona se nalazi u memoriji ra¢unara najcesée u obliku bitmape. Svaki piksel predstavljen je posebno
odgovarajuc¢em brojem bajtova (jedan, dva, tri ili Getiri), u zavisnosti od broja boja sa kojima se radi. Medutim
pri snimanju slike koriste se razlifite kompresije (sazimanja) podataka. Cilj kompresije je smanjenje velic¢ine
datoteke u koju je snimljena slika. Ovo je vazno zbog uStede u zauzeé¢u memorije medija na koji je snimljena
datoteka i, $to je mnogo vaznije zbog smanjenja obima podataka koje treba preneti.

Nagin na koji je crtez snimljen u datoteku primenom neke tehnike (bez kompresije ili sa kompresijom
podataka) zove se format podataka. Tokom razvoja programa za obradu crteza i slika poslednjih nekoliko

godina razvijeno je viSe formata za njihovo ¢uvanje od kojih su ovde pomenuti samo najznacajniji.



2.3 Formati za vektorsku grafiku

Gotovo svaki program za crtanje zasnovan na vektorskoj grafici ima svoj format u kome snima crtez i ovi
fomrati se ¢esto menjaju ¢ak i sa novim verzijama programa. Zbog toga je Cesto tesko crtez nacrtan u jednom
programu uneti i menjati u drugom.

Jedan od Cestih formata za razmenu crteza medu vektorskim programima je DXF (Drawing Exchange
Format - format za razmenu crteza). Organizacija World Wide Web Consortium (poznatija kao W3C) koja se
bavi standardizacijom tehnologija koje se koriste na vebu preporuéila je 2001. novi fomat - SVG. SVG (Scalable
Vector Graphics) je jezik za prikazivanje i ¢uvanje dvodimenzionalne vektorske grafike, bilo nepokretne ili

pokretne (animirane). Ovaj standard je kasnije imao jo§ dve verzije 2003. i 2006. godine.

2.4 BMP format

BMP je najznacajniji format za ¢uvanje slika. Kod njega se u datoteci ¢uva svaki piksel slike pojedinacno sa
odgovarajuc¢im brojem bajtova. Nema nikakve kompresije podataka tako da su datoteke, ¢ak i sa slikama male

veli¢ine, vrlo velike. Pri ovom nacinu ¢uvanja nema gubitka podataka o elementima slike.

2.5 GIF format

GIF format izvodi kompresiju bez gubitaka tako §to niz istih piksela ¢uva kao jedan simbol pomnozen sa
brojem njegovih ponavljanja. Pri ovakvoj kompresiji nema gubitaka podataka. GIF format je ogranifen na
paletu od 256 boja [2]. To zna&i da bez obzira koliko boja sadrzi slika, ovaj broj mora da se svede na najvise
256. Na ovaj nacin je znacajno smanjen broj podataka, Sto znaci i krac¢e datoteke, kao i krac¢e vreme prenosa
preko Interneta, i kra¢e vreme ucitavanja u prezentacijama.

U ovaj format je uklju¢ena i moguénost da se u jednoj GIF datoteci ¢uva i vise slika. Ove slike mogu da
se prikazuju u sekvencama nalik animiranim filmovima pri ¢emu moze i da se podeSava duzina vremenskog
intervala koji ¢e proé¢i izmedu ucitavanja svake slike. Ove animacije mogu da se prikazu samo jednom ili da se

ponavaljaju vise puta.

2.6 JPG ili JPEG format

JPEG je standard kompresije koji je razvijen kako bi se smanjila veli¢ina datoteke slika u boji. Zasniva se
na prirodi ljudskog opazanja, odnosno osobini oka da bolje detektuje povrSine i oblike nego male razlike u boji,
zasencenja i detalje u pokretu. Ovaj metod sazima upravo te varijacije u boji i osvetljenju. JPEG spada u grupu
kompresija sa gubitkom, §to znaéi da se u procesu dekodiranja ne mogu rekonstruisati odstranjene informacije.

JPEG razbija sliku u grupe sli¢ne boje i proseénu vrednost osvetljenja i boje u grupi pamti za celu grupu
[3]. Moze se definisati da se razlika u nijansama boje susednih piksela koja je manja od odredenog zadatog
procenta smatra istom bojom, §to dodatno povecéava kompresiju podataka.

Zbog ovih osobina koris¢enje JPEG formata za oStru grafiku sa velikim podruéjima iste boje obi¢no daje

slabe rezultate. U takvim slucajevima GIF je bolji izbor i kompresuje datoteke mnogo bolje nego JPEG.



Medutim, JPEG je bolji kao metod kompresije i sa stanovista veli¢ine datoteke i sa stanovista kvaliteta kada se

primenjuje na slike koje sadrze Sirok raspon vrednosti boja.

2.7 MPEG format

MPEG je oblik kompresije dizajniran za komprimovanje pokretnog videa. Baziran je na ideji JPEG metode
s tim $to uvodi sazimanje izmedu slika. Primena ove metode omogucava veliki stepen kompresije uz dobar
kvalitet slike. Ovaj metod moZze da se koristi i samo za kompresiju zvuka.

PNG je format bez gubitaka, $to znaci da koji god podatak postoji u originalnoj datoteci postojace i kada se
slika, dekodira. Nije ograni¢en na 256 boja. S obzirom na to da je ovaj format bez gubataka, veli¢ina datoteka

sa slikom u ovom formatu je nekoliko puta vec¢a od odgovarajuce datoteke u JPEG formatu.

2.8 PNG format

PNG datoteke su zbog efikasnije tehnike kompresije naj¢es¢e manje od odgovaraju¢ih GIF datoteka istog
kvaliteta, ali mogu biti i mnogo vece u slucajevima kada su kreirane od slika visokog kvaliteta, jer PNG ima
mnogo veée mogucnosti za ¢uvanje raznolikosti boja od GIF-a.

S obzirom na to da je animirani GIF ostao u Sirokoj primeni, razvijene su dve varijante PNG-a koje podr-
Zavaju animacije. Jedna je MNG razvijena 2001, ali je podrzava malo aplikacija. Druga je APNG (Animated
PNG). PNG grupa je u aprilu 2007. godine zvani¢no odbacila APNG kao zvani¢no prosirenje PNG-a.

2.9 TIFF format

TIFF je format koji se ranije mnogo koristio za Cuvanje skeniranih fotografija. Primenjuje isti postupak
kompresije bez gubitaka kao i GIF. Poslednjih godina se rede koristio zbog najave Unisys-a (nosilac patentnog
prava za GIF) da ¢e da naplacuje liencu. S obziromna to da je patentno pravo Unisys-a isteklo primecuje se
ponovno njegovo kori§¢enje. Datoteke nisu tako male kao kod JPEG-a, ali odrzava kvalitet slike. Kreirane

datoteke su u proseku upola manje nego bez kompresije.



3 Program Bojanka

3.1 O programu

Bojanka (Paint) je program za obradu slika skromnih moguénosti. Ovim programom mogu da se prave nove
slike i da se obraduju i preraduju postojece slike. Program se pokrecée klikom na Start > Programi > Pribor
> Bojanka.

Pomocéu ovog programa mogu da se:

e prave linije razli¢itih debljina i boja,

e povlace potezi Cetkicama razlic¢itih stilova, debljina, nijansi i boja,
e dodaju tekstovi razli¢itih dimenzija, stilova i boja,

e crtaju figure nepopunjene ili popunjene razli¢itim bojama,

e rotiraju i preslikavaju delovi slike,

e iseCe deo slike i premesti na drugo mesto,

e promeni boja dela slike, kao obriSe deo slike.

3.2 Traka sa alatima

Iznad radne povrSine nalazi se traka sa alatima podeljenim u dve kartice i vise kategorija.
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Slika 2: Alati u prvoj kartici

U prvoj kartici Home nalaze se kategorije:
e Clipboard - alati za kopiranje i isecanje obelezenog dela i nalepljivanje kopiranog dela;

e Image - alati za oznacavanje dela slike, odsecanje, menjanje veli¢ine, rotiranje i preslikavanje slike ili dela
slike;

e Tools - alati za crtanje olovkom, brisanje, popunjavanje bojom zatvorenih figura, unosenje teksta, uveca-

vanje i umanjivanje i odredivanje boje na odredenom mestu slike;
e Brushes - alat za crtanje ili farbanje razli¢itim tipovima ¢etkica ili spreja;

e Shapes - alati za crtanje razlicitih figura, oredivanje boje linije i unutrasnje boje;



e Colors - alati za izbor boje i debljine linije prilikom crtanja.
U drugoj kartici View nalaze se kategorije:

e Zoom - alati za uvecanje ili umanjenje slike;

e Show or hide - opcije prikazavanja ili uklkanjanja lenjira oko slike, mreze horizontalnih i vertikalnih

linija i statusne linije;

e Display - opcija prikazivanja slike na celom ekranu ili delu ekrana;

Home View
@ & oy Rulers [~
-{ \‘{ —r Gridlines L‘(j

Zoom Zoom 100 Full Thumbnail
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Zoom Show or hide Display

Slika 3: Alati u drugoj kartici
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4 Program Microsoft office picture manager

4.1 O programu

Microsoft Picture Manager je program koji se nalazi u programskom paketu MS Office i to u folderu MS
Office Tools. Podrzava sledece tipove slika: jpg, jpeg, jpe, jfif, gif, bmp, dib, png, tif, tiff, wmf, emf. Dakle, u
pitanju je program za rad sa bitmapiranim slikama.

Program je namenjen za:

e pregledanje sadrzaja foldera u kojima nam se nalaze slike,

automatsko korigovanje slika od strane ra¢unara (osvetljenost, boja),

e promenu pojedina¢nih parametara slike, kao Sto su: osvetljenost, kontrast, boja, odcesanje, rotiranje,

preslikavanje, uklanjanje crvenih o¢iju, promenu fizickih dimenzija slike, kompresiju slike,

e preimenovanje i izvoz slika iz programa u drugim tipovima zapisa,

pregled karakteristiika slike.

Program se pokrece na Start > Svi programi > Microsoft Office > Micrtosoft Office Tools >
Microsoft Picture Manager ili desnim klikom na sliku, pa Open With > Microsoft Picture Manager
pri ¢emu program otvara odgovarajudi fajl.

4.2 Lociranje slika

Koristec¢i program mogu se pretrazivati hard diskovi i drugi mediji i dodati folderi koji sadrze slike u Shortcut
menu [4]. Na taja nafin se omogucava laksi pristup slikama, kao i folderima koji sadrze slike. Za pretragu foldera

sa slikama treba uraditi sledece:
1. File > Locate Pictures.

2. Odabrati hard disk u padaju¢em meniju sa desne strane i podvrditi klikom na OK kako bi se zapocela

pretraga.
3. Program c¢e dodati sve foldere u kojima se nalaze slike u Picture Shortcuts (sa leve strane).

Folder u Picture Shortcuts moze se dodati i ru¢no klikom na File > Add Picture Shortcut.

4.3 Osvetljenost i kontrast

Promena osvetljenja, kao i razlike izmedu tamnijih i svetlijih tonova na slici vr§i se pomocu alata do kog se
dolazi klikom na Picture > Brightness and Contrast.
Na desnoj strani ¢e se pojaviti podeSavanja parametara osvetljenosti, kontrasta, srednjih nijansi, a klikom

na more mogu promeniti i parametre za svetlije tonove i senke.
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Pomeranjem klizaca za osvetljenost (Brightness) moZe smanjiti ili povecati osvetljenost. Kontrast (Contrast),

srednji tonovi (Midtone), svetli tonovi (Highlight) i senke (Shadow) se pode$avaju na isti nacin.

Slika 4: Oswvetljenge slike od - 30 do 30

4.4 Boja

Boja na slici se menja pomocu alata za promenu boje. Alatu se moZe pristupiti na Picture > Color.

Na desnoj strani pomeranjem klizaca moze se promeniti nijansa, jac¢ina i zasi¢enje, kao i da se prepusti
programu da automatski koriguje boje, klikom na Encance color.

Pomeranjem kliza¢a Hue bira se nijansa iz spektra boja. Nakon toga podeSavanjem klzac¢a Amount bira

se intenzitet odabrane nijanse, dok ¢isto¢u boje, od sive do odabrane boje, je moguée namestiti pomocu klizaca

Saturation.

Slika 5: Menjanje boje slike

4.5 Odsecanje dela slike

Program Microsoft picture manager sadrzi moguénost odsecanja dela slike. Do alata koji se koristi za to se
dolazi na Picture > Crop.

Na ivicama slike ¢e se pojaviti grani¢nici ¢ijim pomeranjem moZe da se oznaci deo slike koji ostaje (tamniji
deo slike), dok ¢e ostatak slike (svetliji deo) biti izbrisan. PodeSavanja ¢e se takode pojaviti i sa desne strane
slike i tu moze da se izabere odreden proporcionalan odnos visine i Sirine slike, kao i koliko piksela od odredene

ivice ¢e biti uklonjeno.
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Slika 6: Odsecanje dela slike

4.6 Rotiranje i preslikavanje slike

Slike koje su nastale prilikom fotografisanja, i rotiranja kamere ili fotoaparata, mogu bit rotirane za ugao od
90° u jednu stranu. Da bi se to popravilo koristi se alat kojim je moguce rotirati sliku za odreden ugao, kao i
preslikati sliku po horizontalnoj ili vertikalnoj osi. Da biste iskoristili alat, potrebno je kliknuti na Picture >
Rotate and Flip.

Sa desne strane slike ¢e se pojaviti opcije:

¢ Rotate left - rotira sliku za 90° u levo;

Rotate right - rotira sliku za 90° u desno;

By degree - rotira sliku za proizvoljan ugao;

Flip horizontal - preslikava sliku po vertikalnoj osi;

Flip vertical - preslikava sliku po horizontalnoj osi.

Slika 7: Rotiranje slike
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4.7 Uklanjanje crvenih oéiju

Efekat crvenih oc¢iju nastaje odbijem svetlosti blica od mreznjace oka. Da bi se uklonio, koristi se alat,
nalik na niSan, kojim se oznacavaju zenice koje su na fotografiji crvene. Opcijom OK potvrdujemo korekciju
a opcijom Reset Selected Eyes ponistavamo selekciju. Pokretanje alata se vrsi klikom na Picture > Red

Eye Removal pri ¢emu se sa desne strane pojave navedene opcije.

Slika 8: Uklanjanje crvenih ociju

4.8 Promena dimenzija slike

Slike dobijene fotografisanjem obi¢no su dimenzija koje fotoaparat omoguéava. S obzirom da dimenzije slike
zavise od njene namene, ponekad je potrebno prilagoditi visinu i Sirinu slike. Klikom na Picture > Resize
dolazimo do alata kojim mozemo da menjamo veli¢inu slike. Na desnoj strani ¢e se pojaviti podeSavanja kojima

moze da se promeni visina i Sirina slike. Postoje tri nacina da se to uradi:
e U polju Predefined width x height moze da se izabere neki od ponudenih formata;
e U polje Custom width x height mogu upisati dimenzije po licnom izboru;

e UnoSenjem procentualnog dela originalne veli¢ine u polje Percentage of original width x height.

4.9 Kompresija slike

Slike velikog kvaliteta i rezolucije, kao i odredenih formata (poglavlje 2) mogu imati velike datoteke, koje
zauzimaju veliki prostor ili ih nije moguée poslati e-mailom. Kompresija slike je opcija koja se koristi slucaju

kada je potrebno da se napravi slika manje veli¢ine, takva da se moze postaviti na internet ili poslati na e-mail,
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ali da nema problema sa dugim otpremanjem sadrzaja. Ovaj alat se pokrece klikom na Picture > Compress
Picture
Sa desne strane se bira da li se slika kompresuje za neki dokument, web stranicu ili e-mail poruku i klikom

na OK se potvrduje izbor.

4.10 Promena formata slike

Ukoliko je potrebno da se promeni tip slike, to moze da se uradi preko opcije za izvoz slika. Ova opcija
moze da se nade klikom na File > Export. Potrebno je izabrati folder u koji ¢ée slika biti smestena. U slucaju
da je selektovana opcija Original location, slika ¢e biti smestena u isti direktorijum kao i original. Potrebno
je izabrati ime fajla ili zadrzati staro ime. Selektovanjem opcije Original file name, naziv slike ¢e ostati
nepromenjen. Format slike se moze promeniti u padaju¢em meniju Export with this file format. Veli¢ina

slike se moze promeniti izborom jedne od ponudenih opcija iz padaju¢eg menija Export with this size.
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5 Program ACDSee

5.1 O programu

ACDSee je jedan od najpopularnijih i najdugovecnijih programa za pregled, organizaciju i obradu slika. Uz
ovaj program mozete skinuti slike, prebaciti ih sa telefona ili fotoaparata, podeliti u razli¢ite kategorije, sortirati,
pretrazivati i ukloniti duplikate.

Takode, ACDSee sadrzi i alate kojima mozete kreirati, menjati i podeSavati razne opcije na digitalnim
fotografijama. Mogu se koristiti alati za odsecanje delova slike, promenu veli¢ine i formata, menjanje osvetljenja,
boje i kontrasta, ali i alati za dodavanje, teksta, zigova, okvira slike i specijalnih efekata.

Program se pokreée klikom na Start > Svi programi > ACD Systems > ACDSee Pro i zatim je
potrebno pronadi sliku koju zelimo izmeniti. Takode moguce je otvoriti odredenu sliku desnim klikom na sliku,

pa Otvori pomocéu > ACDSee Pro.

5.2 Traka sa alatima

Posle pokretanja programa sa leve strane prozora nalazi se traka sa alatima (Edit Mode Menu) gde se
nalazi spisak alata koji sluze za uredivanje slike. Podeljeni su u alate za popravljanje delova slike, alate za
dodavanje, geometrijske alate, alate za rad sa osvetljenjem i kontrastom, alate za podeSavanje boje i alate za
podeSavanje detalja na slici [5].

Za vecinu alata i efekata, iznad prozora za podeSavanja, pojavljuju se opcije kojima je moguée podesiti koji
deo slike se menja. Izborom ¢etkice, alat primenjujemo klikom na deo slike koji Zelimo. Takode je moguce alat
primeniti na deo slike sa jedne strane prave, kao i na oblast unutar ili izvan kruga. U slucaju da nista nije
izabrano ili ta opcija za odredeni alat ne postoji, efekat se primenjuje na celu sliku.

Posto se podese parametri za neki alat, da bi se zavr§io proces, potrebno je potvrditi promene klikom na

Done. Klikom na Cancel ponistavaju se promene za taj alat.

5.3 Uklanjanje crvenih oc¢iju

Problem koji se najcesée javlja pri fotografisanju je problem crvenih oc¢iju. Na vrhu liste sa leve strane se
nalazi alat za uklanjanje crvenih o¢iju. Izborom tog alata pojavljuje se krsti¢, kao meta kojim se oznaci mesto

gde se nalaze crvene oCi. Sa leve strane se pojavljuju dva klizaca:
e Size - menja se veli¢ina crvenih o¢iju, tj. deo koji treba da promenimo;
e Darkness - menja se nijansa kojom Zelimo da zamenimo crveni deo o¢iju.

Posle podesavanja, zavrietak procesa potvrdimo na OK u levom donjem uglu.
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5.4 Alat za popravke

Slike nastale fotografisanjem mogu da sadrZe neke nezeljene detalje kao posledicu kori§éenja blica, izgleda
okoline ili trenutka slikanja. Poravke detalja na slici omogucava alat kojim moze da se kopira ili delimi¢no
prenese deo slike na drugo mesto. Pokreéemo ga klikom na Repair tool na traci sa alatima i na slici se
pojavljuje krug, a oko njega drugi krug nacrtan isprekidanom linijom. Desnim klikom se oznacava deo koji se

kopira, a levim posle toga deo na koji kopiramo. Sa leve strane se nalaze podesavanja:

e Heal i Clone - izborom prvog prenosi se samo kontura na drugo mesto dok boja ostaje priblizno ista,

dok izborom druge opcije kopira se celi deo slike;
e Nib Width - povecava se ili smanjuje veli¢ina unutrasnjeg kruga;
e Feathering - menja se rastojanje izmedu dva kruga, tj. prelazni deo.

Ovaj alat je koristan kada se uklanjaju bubuljice, tako §to se jedan koZze prenosi na mesto gde se bubuljica

nalazi. Takode se moze koristiti za uklanjanje anomalija nastalih pojavom kapljica vode, zamgljenja i ogrebotina

na objektivu.

Slika 9: Uklanjanje bubuljice pomoéu alata za popravke

5.5 Dodavanje teksta

Alat kojim se dodaje tekst na sliku pokrece se na Text na traci sa alatima i na slici se pojavljuje pravougaonik

sa tekstom, a sa leve strane podesavanja:
e Text - polje za unosenje teksta;
e Font - izbor fonta, boje, veli¢ine, vidljivosti i poravnanja;
e Blend mode - podeSavanja nacina na koji ¢e se tekst megati sa slikom;

e Bubble Text, Effects, Drop Shadow i Bevel - moguénost postavljanja teksta u oblaci¢, postavljanja
senke, izbora nekog efekta ili dodavanja linija da se dobije 3D efekat.
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5.6 Dodavanje ziga

Zig se, obitno, stavlja na sliku iz dva razloga: marketing (npr. ime fotografa koji je napravio sliku) i zagtita
slike od krade (ilegalnog stampanja). Alat, koji sluzi za dodavanje slike na postojecu sliku kao Ziga, se pokrece

klikom na Watermark na traci sa alatima i podeSavanja koja se koriste su:

e Watermark image - biranje slike za vodeni zig;

Maintain aspect ratio when resizing - zadrzava isti odnos Sirine i visine ubacene slike;

Apply Alpfa Channel i Apply Transparency - podeSavanje vidljivosti na pozadinskoj slici;

e Blending Mode - nacin meSanja dve slike;

Opacity - podeSavanje providnosti slike koja se ubacuje.

5.7 Dodavanje okvira
Okvir oko slike se dodaje klikom na Border na traci sa alatima i pojavljuju se opcije:
e Border - podesavanje veli¢ine i boje okvira;
e Edge - podesavanje pravilnog ili nepravilnog oblika okvira i njegovog odnosa sa slikom;

e Edge Effects - moguénost dodavanja senke ili 3D efekta na okvir.

5.8 Zatamnjivanje ivica i uglova slike

Alat koji omogucéava zatamnjivanje ili promenu izgleda ivica slike pokrece se na Vignette na traci sa alatima

i pojavljuju se opcije:

e Horizontal - podesavanje horizontalnog centra vidljive oblasti;

Vertical - podeSavanje vertikalnog centra vidljive oblasti;

Clear Zone - podesavanje veli¢ine vidljive oblasti;

e Transition zone - podeSavanje veliCine prelazne oblasti, tj. oblasti u kojoj je slika malo zatamnjena;

Strech - podesavanje da li je vidljiva oblast razvucena po nekoj osi;

Shape - podesavanje oblika vidljive oblasti;

Frame - biranje izgleda ivica.
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5.9 Specijalni efekti

Postoji mnogo gotovih efekata koji se mogu koristiti. Pristup tim efektima je klikom na Special Effect na
traci sa alatima. Pojavice se lista efekata sa leve strane, ali i prozor¢iéi sa potencijalnim izgledom slike. Efekat
se aktivira klikom na odgovarajucu sliku ili na efekat sa liste. Po zavrSetku podeSavanja parametar kod efekta

potrebno je potvrditi klikom na Done.

Slika 10: Lista specijalnih efekata

Efekat prozora kupatila se koristi da se dobije slika podeljena na manje pravougaonike stvarajuéi sliku koja
podseéa na pogled kroz staklo u ranijim kupatilima ili na pogled u prostoriji sa mnogo ogledala. Pokretanje

ovog efekta se vrsi na klikom na Bathroom Window na listi specijalnih efekata i pojavljuju se podeSavanja:
e Bar width - odreduje Sirinu pravougaonika;
e Bar direction - odreduje da li su pravougaonici horizontalni ili vertikalni.

Efekat roletni deli sliku paralelnim linijama i zatamnjuje ili menja boju uz ivicu svakog dela. Pokrece se

klikom na Blinds na listi specijalnih efekata. PodeSavanja za ovaj efekat su:
e Width - Sirina svakog dela;
e Opacity - prozirnost zatamnjenih delova;
e Angle - ugao pravca linija kojima se slika deli;

e Blind color - boja kojom zatamnjujemo ivice svakog dela.
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Efekat plavog celika daje slici karakteristi¢nu plavu boju. Pokreée se klikom na Blue Steel na listi specijalnih
efekata.
Efekat bojenja Cetkicom slici daje izgled kao da je umetnicko delo, napravljeno kistom. Pokrece se klikom

na Bob Ross na listi specijalnih efekata i pojavljuju se opcije:
e Brush size - veli¢ina Cetkice;
e Coverage - koji deo slike je pokriven bojenjem cetkicom;
e Paint thikness - debljina nanosa boje;
e Colorfulness - intenzitet boje;
e Background color - izbor originalne slike ili boje za pozadinu;

e Randomize - posto su mesta na koja se boja nanosi proizvoljna, menja mesta tih nanosa, a samim tim i

izgled slike.

Slika 11: Redom, originalna slika, efekat prozora kupatila, efekat roletni, efekat plavog celika

Efekat ispupcenja umanjuje ili uvecava neki deo slike, pri ¢emu se drugi deo rastegne ili skupi. Pokretanje i

podesavanja se pojavljuju klikom na Bulge na listi specijalnih efekata:

e Horizontal position - centar na horizontalnoj osi;

Vertical position - centar na vertikalnoj osi;

Radius - veli¢ina oblasti koja se menja;

Strength - intenzitet uveéanja ili umanjenja;

e Backgrund color - boja pozadine;

e Bulgde direction - pravac umanjivanja ili uve¢avanja.

Efekat crtanog filma daje slici izgled skice pri ¢emu se boja zadrzava. Klikom na Cartoon pokre¢emo efekat

i pojavljuju se podesavanja:

20



e Shading strength - intenzitet boje senke;

e Shading radius - duZina senke;

e Shading treshold - odreduje koje ¢e linije biti predstavljene kao skice;
e Smoothness - odreduje prelaz izmedu boja na slici;

e Outline detail - odreduje koliko linija ¢e biti podebljano;

e Outline strength - odreduje debljinu linija;

e Remove small details - uklanjanje veoma malih detalja.

Efekat slike iz detinjstva daje slici nostalgican izgled, tj. izgled fotografija starije izrade. Pokrece se klikom
na Childhood na listi specijalnih efekata.
Efekat kolaza deli sliku na manje slike sa okvirom i spaja ih kolaz, tj. kao da su nenamerno stavljene na

jednu gomilu. Pokrecée se klikom na Collage na listi specijalnih efekata:
e Number of Photos - broj slika u kolazu;
e Size - veli¢ina slika u kolazu;
e Background color - boja pozadine;
e Randomize - posto raspored slika nije definisan, menja ih i na taj na¢in menja celu sliku.

Efekat obojenih linija pronalazi linije i detalje na slici i boji ih odredenom bojom. Pokrece se klikom na

Colored Edges pri ¢emu se pojavljuju podeSavanja:
e Intensity - intenzitet boje linija;
e Egde color - boja linija;
e Edge detection - nacin detektovanja;
e Use bluring - odreduje zamagljenost slike i na¢in na koji je slika zamagljena.

Efekat kontura iscrtava krive zatvorene linije na slici da bi se dobio efekat kao u crtanom filmu. Pokrece se

klikom na Contours na spisku specijalnih efekata i pojavljuju se podesavanja:

Rounding - podeSavanja koliko je linija zaokrugljena, tj. broj zakrivljenih delova u jednoj liniji;

e Line Frequency - podesavanje koliko su linije Ceste, tj. koliko je razmak izmedu linija;

Strength - podesavanje koliko je linija tamna;

Line Color - izbor boje linije.
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Slika 12: Redom, efekat bojenja cetkicom, efekat ispupcenga, efekat crtanog filma i efekat slike iz detinjastva

Efekat bojica slici daje izgled kao da je nacrtana bojicama. Pokrecée se klikom na Crayon Drawing na
spisku specijalnih efekata.

Efekat srafiranja dodaje lagane kose poteze olovkom na sliku. Pokreée se klikom na Crosshatch na spisku
specijalnih efekata.

Efekat Cetkice za farbanje deli sliku na delove koje preklapa i postavlja na originalnu sliku ili odredenu boju
i na taj nacin dobija efekat farbanja. Pokrece se klikom na Dauber na spisku specijalnih efekata i pojavljuju

se podeSavanja:
e Intensity - odreduje veli¢inu delova, tj. veli¢inu pokreta Cetkice;
e Frequency - odreduje broj delova, tj. broj pokreta Cetkice;
e Background Color - izbor pozadine, tj. odredene boje ili originalne slike.

Efekat dramati¢nog izgleda menja kontrast u delu slike ili na celoj slici. Pokreée se klikom na Dramatic na

spisku specijalnih efekata i pojavljuju se podesavanja:
e Strength - odreduje ja¢inu kontrasta;

e Spread - odreduje oblast na slici na kojoj je kontrast primenjen.

Slika 13: Redom, efekat kolaZa, efekat obojenih linija, efekat kontura i efekat bojica
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Efekat detektovanja kontura detektuje linije na slici, tj. najmanje razlike u boji i te linije boji odredenom
bojom, dok je ostatak slike crn. Sto je veca razlika u bojama na slici, to je deblja linija koja obelezava tu razliku.
Pokrece se klikom na Egde Detect na spisku specijalnih efekata.

Efekat reljefa prikazuje sliku kao konture na sivoj pozadini, pri tome stvarajuéi reljefni izgled. Pokrece se

klikom na Emboss na spisku specijalnih efekata i pojavljuju se podeSavanja:
e Elevation - odreduje visinu svetlosti koja pada na sliku, tj. koliki je osvetljeni deo slike;
e Weight - odreduje koli¢inu reljefa na slici;
e Azimuth - odreduje ugao pod kojim senke padaju.

Efekat krzna detektuje linije na slici i, pocevsi od njih, dodaje linije, nalik na dlac¢ice. Uz odredena podesa-
vanja dobija se efekat kao da je dodato krzno. Pokrece se klikom na Furry Egdes na spisku specijalnih efekata

i pojavljuju se podesavanja::
e Frequency - odreduje broj linija;

e Threshold - odreduje na koje ivice ¢e biti dodate linije, tj. koliko izrazene ivice moraju biti da bi se na

njih primenio efekat;
e Fur Length - odreduje duzinu linja;

e Variance - odreduje koji deo linija je nacrtan u istom smeru, a koliko linija je nacrtano u proizvoljnom

smeru;
e Hair direction - odreduje smer u kom se linije crtaju;

e Edge detectoin - odreduje nacin detektovanja ivica;

e Background color - izbor boje pozadine ili originalne slike;
e Fur color - izbor boje linija, tj. krzna;

e Radnomize - linije se dodaju na mesta odredena sluc¢ajnim izborom, tako da klikom na ovu opciju, linije

se ponovo rasporeduju.

Efekat svetlecih ivica detektuje linije i uz njih dodaje odredenu boju. Pokrece se klikom na Glowing Egdes

na spisku specijalnih efekata i pojavljuju se podeSavanja:
e Intensity - odreduje koliko boje se dodaje;
e Color - izbor boje koja se dodaje.

Efekat crtanja na kamenu sliku prikazuje kao da je naslikana na granitu. Pokrece se klikom na Granite na

spisku specijalnih efekata i pojavljuju se podesavanja:
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Slika 14: Redom, efekat Srafiranja, efekat cetkice za farbanje, efekat dramaticnog izgleda i efekat detektovanja kontura

e Light angle - odreduje ugao pod kojim pada svetlost, a samim tim i ugao pod kojim padaju senke.

Lomo efekat daje slici starinski retro izgled, sa mnogo kontrasta, zatamnjenih ivica i zuc¢kaste boje. Pokrece

se klikom na Lomo na spisku specijalnih efekata i pojavljuju se podesavanja:
e Color Distortion - odreduje jac¢inu kontrasta i koli¢inu zute boje;
e Vignette Strength - odreduje koliko su ivice zatamnjene.

Efekat ogledala odredenu osu na slici ¢ini ogledalom i na taj nacin preslikava jedan deo slike na drugi.

Pokrece se klikom na Mirror na spisku specijalnih efekata i pojavljuju se podeSavanja:
e Mirror axis - odreduje gde se nalazi osa koja predstavlja ogledalo;
e Mirror direction - bira da li je osa horizontalna ili vertikalna.

Ovaj efekat kreira svaku boju preslikava u njenu inverznu, tj. svetle delove slike ¢ini timnim i obrnuto. Moze

se koristiti da od skeniranog negativa neke slike dobijemo sliku. Pokreée se klikom na Negative na spisku

specijalnih efekata.

Slika 15: Redom, efekat reljefa, efekat krzna, efekat svetleéih ivica i efekat crtanja na kamenu

Efekat ulja na platnu slici daje izgled umetnicke slike naslikane na platnu. Pokreée se klikom na Oil Paint

na spisku specijalnih efekata i pojavljuju se podeSavanja:

e Brush width - odreduje debljinu cetkice kojom se slika;
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e Variance - odreduje nijanse jedne boje u jednom pokretu;
e Vibrance - odreduje intenzitet boja na slici.

Efekat starenja slike daje slici izgled stajanja odreden broj godina, tako §to dodaje zZuckastu zlatnu boju i
smanjuje kontrast, tj. poveéava gubljenje boja tokom godina. Pokrece se klikom na Old na spisku specijalnih

efekata i pojavljuju se podeSavanja:
e Age - odreduje kontrast i koli¢inu zute boje, §to odgovara broju godina koliko je slika stara.

Efekat obrnutih kontura dektuje linije i ostavlja ih iste kao na originalnoj slici, dok ostatak slike boji odre-

denom bojom. Pokrece se klikom na Outline na spisku specijalnih efekata i pojavljuju se podesavanja:
e Line Width - odreduje debljinu oblasti oko linija koja ostaje ista;
e Treshold - odreduje koliko izrazene linije treba da budu da bi bile obeleZene;
e Background color - izbor boje kojom ¢e ostatak slike biti obojen.

Efekat crtanja olovkom slici daje izgled crteza u crno beloj boji, tako §to detektuje izrazene linije i crta ih

crnom bojom na beloj pozadini. Pokreée se klikom na Pencil Draw na spisku specijalnih efekata.

Slika 16: Redom, Lomo efekat, efekat ogledala, efekat negativa i efekat ulja na platnu

Efekat eksplozije piksela stvara utisak eksplozije u jednoj tacki i uticaj toga na celu sliku, tj. na svaki piksel
koji se prenosi na drugo mesto. Pokrece se klikom na Pixel Explosion na spisku specijalnih efekata i pojavljuju

se podeSavanja:

e Horizontal center - odreduje horizontalnu poziciju centra;

Vertical center - odreduje vertikalnu poziciju centra;

Intensity - odreduje snagu eksplozije, tj. okvirnu daljinu gde ¢e se odredeni piksel preneti;

e Explosion direction - odreduje da li ¢e se pikseli prenositi horizontalno, vertikalno ili u oba pravca;

Randomize - svakim klikom kreira malo drugaciju sliku jer je udaljenost na kojoj se pikseli prenose

okvirna.
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Efekat povecavanja piksela povecava veli¢inu svakog piksela, tj. deli¢u slike, koji bi trebalo da bude veli¢ine
1x1, povecava dimenzije i na taj nacin stvara utisak zamagljenosti na slici. Pokrece se klikom na Pixelate na

spisku specijalnih efekata i pojavljuju se podesavanja:
e Width - odreduje Sirinu svakog dela;
e Height - odreduje visinu svakog dela;
e Square - Stikliranjem ove opcije svaki deo je kvadrat, nezavisno od visine.

Efekat ljubicaste izmaglice, pored zamagljenog izgleda stvorenog manjim kontrastom, dodaje slici i ljubic¢astu

boju. Pokreée se klikom na Purple Haze na spisku specijalnih efekata.

Slika 17: Redom, efekat starenja slike, efekat obrnutih kontura, efekat crtanja olovkom i efekat eksplozije piksela

Efekat talasa pravi pomera deli¢e slike u obliku kruznih krivih linija, oblika talasa, pocevsi od neke tacke.

Pokrece se klikom na Radial Waves na spisku specijalnih efekata i pojavljuju se podesavanja:

e Horizontal position - odreduje tacku centra na horizontalnoj osi;

Vertical posiiton - odreduje tacku centra na vertikalnoj osi;

Amplitude - odreduje amplitudu, tj. rastojanje izmedu donje i gornje granice svakog talasa;

e Wavelength - odreduje duzinu svakog talasa, tj. razliku izmedu pocetka dva uzastopna talasa;

Line strength - odreduje da li se crta linija uz svaki talas, njenu debljinu i intenzitet;

Background color - odreduje boju na ivicama slike ako talasi pomere deo slike;
e Wave direction - odreduje pravac talasa (horizontalno ili vertikalno).

Efekat kise dodaje sitno isprekidane linije istog ili sli¢nog pravca, stvarajuéi utisak da pada kisa. Pokrece se

klikom na Rain na spisku specijalnih efekata i pojavljuju se podeSavanja:
e Strength - odreduje debljinu linija kiSe;

e Opacity - odreduje prozirnost linija;
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Amount - odreduje broj linija;

Angle variance - odreduje koji broj linija nece biti u istom pravcu;

Strength variance - odreduje variranje duZzine linija;

Background blur - odreduje nivo zamagljenosti pozadine;

Angle - odreduje ugao pod kojim pada kisa;
e Color - izbor boje linija koje predstavljaju kapi.

Efekat koncentri¢nih talasa stvara koncentri¢ne krugove koji se §ire, ¢inec¢i efekat kao kad kamenci¢ padne u

vodu. Pokrece se klikom na Ripple na spisku specijalnih efekata i pojavljuju se podeSavanja:

Horizontal position - centar na horizontalnoj osi;

Vertical position - centar na vertikalnoj osi;

Amplitude - odreduje visinu talasa, u ovom sluc¢aju daje 3D efekat;

Wavelength - odreduje rastojanje izmedu koncentri¢nih krugova;

Light strength - odreduje kontrast izmedu vrha i podnozja talasa;

Background color - izbor slike ili boje za pozadinu;
e Ripple direction - izbor pravca u kojem se krugovi Sire.

Efekat rasutih ploc¢ica deli sliku na kvadrate i postavlja ih u blizu jedan drugom, ali sa mogucénoséu da
se menjanja rastojanja izmedu njih. Pokrece se klikom na Scattered Tiles na spisku specijalnih efekata i

pojavljuju se podeSavanja:
e Tile size - odreduje veli¢inu kvadrata;
e Scatter amount - odreduje rastojanje izmedu delova, tj. rasutost delova slike;
e Background color - izbor boje za pozadinu.

Efekat pomeranja delova sliku deli paralelnim linijama i te delove pomera duZ odredenog pravca, u jednom

ili drugom smeru. Pokrece se klikom na Shift na spisku specijalnih efekata i pojavljuju se podesavanja:
e Strength - odreduje za koliko se ti delovi pomeraju;
e Width - odreduje §irinu delova, tj. rastojanje izmedu paralelnih linija;
e Angle - odreduje ugao pravca linija i pomeranja;

e Background color - izbor slike ili boje za pozadinu.
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Slika 18: Redom, efekat poveéavanja piksela, efekat ljubicaste izmaglice, efekat talasa i efekat kise

Efekat mozaika deli sliku na delove koji su jednobojni, potom ih spaja i na taj naécin slici daje izgled mozaika.

Pokrece se klikom na Stained Glass na spisku specijalnih efekata i pojavljuju se podeSavanja:
e Fragment size - veli¢ina svakog dela;

e Randomize - posto su delovi nepravilnog oblika, klikom na ovu opciju, svaki deo se menja, pa se i slika

se menja.

Efekat svetle tacke dodaje svetlu tacku ili element sunca na slici. Pokrece se klikom na Sunspot na spisku

specijalnih efekata i pojavljuju se podesavanja:
e Horizontal position - odreduje centar na horizontalnoj osi;
e Vertical position - odreduje centar na vertikalnoj osi;

e Brightness - odreduje ja¢inu sunca, tj. osvetljenja koje se §iri od centra svetle tacke.

Slika 19: Redom, efekat koncentriénih talasa, efekat rasutih plocica, efekat pomeranja delova i mozaika

Efekat vodene povrsine dodaje horizontalno postavljeno ogledalo sa nepravilnostima, tj. talasastim delovima,
stvarajuci, na taj na¢in, vodenu povrsinu. Pokrece se klikom na Water na spisku specijalnih efekata i pojavljuju

se podeSavanja:

e Position - odreduje poziciju vodene povrsine;

28



e Amplitude - odreduje broj talasa na vodenoj povrsini;

e Wavelength - odreduje duzinu talasa na vodenoj povrsini;

e Perspective - odreduje porziciju sa koje se gleda i menja ugao vodene povrsine;
e Lighting - menja osvetljenje vodene povrsine.

Efekat kapljica vode na sliku dodaje sitne okrugle figure, koje daju efekat nakupljanja kapi. Pokreée se

klikom na Water Drops na spisku specijalnih efekata i pojavljuju se podesavanja:
e Density - odreduje broj kapljica;
e Radius - odreduje veli¢inu kapljica;
e Height - odreduje visinu kapljica, tj. daje 3D efekat;

e Randomize - posto je pozicija kapljica nedefinisana, ova opcija daje moguénost novog sluc¢ajnog izbora
njihovih pozicija.

Efekat vetra pomera piksele na slici u odredenom pravcu, stvarajucu utisak da duva vetar odredene brzine.

Pokrece se klikom na Wind na spisku specijalnih efekata i pojavljuju se podeSavanja:
e Strength - odreduje jacinu vetra, tj. za koliko se neki deo pomera;
e Treshold - odreduje koliko izrazene linije treba da budu da bi se delovi pomerali;

e Chance of wind - odreduje koliko delova se pomera;

Edge detection - odreduje nafin detektovanja linija na slici;

Background color - odreduje sliku ili boju pozadine, tj.dela koji se ne pomera;

Wind color - odreduje sliku ili boju dela koji se pomera;

Wind angle - odreduje smer na koji vetar duva, tj. na koju stranu ¢e se delovi pomeriti;

Slika 20: Redom, efekat svetle tacke, efekat vodene poursine, efekat kapljica vode i efekat vetra
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5.10 Rotiranje slike

Fotoaparati koji nemaju postolje ili stabilnu podlogu, ne mogu uvek da stvore sliku koja ¢e imati odgovarajuéi
ugao. Iz tog razloga nekad je potrebno rotirati sliku. Alat koji omogucava rotaciju slike za odreden ugao se

pokrece klikom na Rotation traci sa alatima i potrebno je podesiti parametre:

e Orientation - omogucava rotaciju za jedan od ponudenih uglova;

Straightening - omogucava rotaciju za ugao koji se podesi ili povlace¢i liniju koja ¢e da bude horizontalna

ili vertikalna,

e Crop straightened image - odseca deo slike koji nastaje zbog rotacije;

Preserved straightened image - popunjava deo slike koji nastaje zbog rotacije izabranom bojom;

Show grid overlay - prikazuje mrezu horizontalnih i vodoravnih linija koje omogucéavaju laksi rad.

5.11 Preslikavanje slike

Preslikavanje slike znaci okretanje slike po horizontalnoj ili vertakalnoj osi simetrije. Pokrece se klikom Flip

na traci sa alatima i pri tom se pojavljuju opcije:
e Flip vertically - preslikava sliku po horizontalnoj osi simetrije;

e Flip horizontally - preslikava sliku po vertikalnoj osi simetrije.

5.12 Odsecanje dela slike

Odsecanje dela slike omogucava brisanje dela slike koji nije potreban i pokreée se klikom na Crop na traci

sa alatima i pojavljuju se podeSavanja:
e Constrain croping proportion- odnos visine i 8irine nove slike;
e Landscape - orijentacija izabranih dimenzija;
e Width - Sirina nove slike;
e Height - visina nove slike;
e Units - merna jedinica;
e Resolutions - rezolucija nove slike;
e Estimate new file size - veli¢ina fajla nove slike;

e Darken outside crop area - Zatamnjenje odsecenog dela.
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5.13 Promena persepktive

Promena perspektive omoguéava promenu ugla gledanja na sliku, tj ugla gde bi trebalo da bude fotoaparat,
ako je slika napravljena fotografisanjem. Pokrece se klikom na Perspective Correction na traci sa alatima.

Perspektivu menjamo pomerajuéi uglove i ivice slike, a na levoj strani se pojavljuju podesavanja:
e backgroud color - izbor originalne slike ili boje za pozadinu;

e show grid - prikazuje mrezu horizontalnih i vertikalnih linija.

5.14 Promena veli¢ine

Promena velicine slike se vrsi kad je potrebno sliku prilagoditi nekim dimenzijama. Pokrece se klikom na
Resize na traci sa alatima. Veli¢inu slike je moguée promeniti na viSe nacina - unoseéi veli¢inu u pikselima,
odgovarju¢im mernim jedinicama, procentualno u odnosu na pocetnu veli¢inu slike, pri tom zadrzavajuéi ili
menjajuéi odredeni odnos visine i Sirine slike.

5.15 Promena kontrasta i osvetljenja

Promena kontrasta menja razliku izmedu svetlih i tamnih tonova na slici, dok promenom osvetljenja menja
se nijansa svake boje, od svetle do tamne. Pokrece se klikom na Exposure na traci sa alatima. PodeSavanja

za ovaj alat su:
e Exposure - odreduje osvetljenje slike;
e Auto - automatski odreduje osvetljenje;
e Contrast - odreduje kontrast;
e Fill Light - menja boju u tamnijim delovima slike.

Promenu osvetljenja je moguce ostvariti i klikom na Lighting na traci sa alatima pri tom podeSavajuci
koli¢inu svetlosti na klizac¢u, dok je automatsku promenu boje i kontrasta moguce izvr§iti klikom na Auto
levels i pri tom podesiti koliki je uticaj te promene.

Naprednijim i detaljnijim podeSavanjima se pristupa klikom Levels, Tone Curves i Dodge and Burn.

5.16 Uklanjanje nijansi

Uklanjanje nijansi je alat kojim moze da se potpuno ili delim¢no ukloni neka boja sa slike. Pokrece se klikom

na White Balance na traci sa alatima. Na slici se ozna¢i mesto sa bojom za uklanjanje i podese parametri:
e Selected color - prikazuje izabranu boju sa slike i nijansu te boje kojom se menja;

e pomeranjem kliza¢a menja se nijansa kojom Zelimo da zamenimo izabranu boju.
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5.17 Detaljno menjanje nijansi

Detaljno menjanje nijansi je alat koji omoguéava promene boje, intenziteta, zasicenosti i osvetljenja poje-
dina¢nih boja, kao i zasi¢enosti i intenziteta istovremeno svih boja na slici. Pokrecée se klikom na Advanced

Color na traci sa alatima i pojavljuju se podeSavanja:
e Vibrance - odreduje jac¢inu boje;
e kliza¢ Saturation - odreduje zasi¢enje boja na celoj slici;

e kartica Saturation - omogucava promenu zasi¢enosti pojedina¢ne boje pomeranjem odgovarajuceg kli-

zaca;

e kartica Brightness - omogucava promenu osvetljenja pojedina¢ne boje pomeranjem odgovarajuceg kli-

zaca;

e kartica Hue - omogucava promenu nijanse pojedinacnie boje pomeranjem odgovarajuceg klizaca.

5.18 Promena odnosa boja

Promena odnosa boja omogucava promenu jacine boje, zasi¢enosti, nijansi i osvetljenja, kao i menjanje
intenziteta unosa crvene, zelene i plave boje §to menja odnos svih boja na slici. Pokreée se klikom na Color

Balance na traci sa alatima. Parametri za ovaj alat su:
e Vibrance - odreduje ja¢inu boja;
e Saturation - odreduje zasi¢enost boja;

e Hue - odreduje nijansu boje;

Lightness - odreduje osvetljenje;
e Red - odreduje jacinu crvene boje;
e Green - odreduje nijasnu zelene boje;

e Blue - odreduje nijansu plave boje.

5.19 Prebacivanje u crno-belu sliku

Prebacivanje u crno-belu sliku automatski smanjuje zasi¢enost boja i na taj nacin stvara crno-belu sliku.

Pokrece se klikom na Convert to Black & White na traci sa alatima. PodeSavanja za ovaj alat su:

e Percent Red - odreduje intenzitet unosa crvene boje na slici pre prebacivanja u crno-belu;
e Percent Green - odreduje intenzitet unosa zelene boje na slici pre prebacivanja u crno-belu;
e Percent Blue - odreduje intenzitet unosa plave boje na slici pre prebacivanja u crno-belu;

e Percent Brightness - odreduje osvetljenje na slici.
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5.20 razdvajanje tonova

Razdvajeanje tonova je alat koji omguéva promenu tamnijih i svetlijih delova slike i njihovog odnosa. Pokrece

se klikom na Split tone na traci sa alatima i podeSavaju se parametri:

e Highlights Hue - odreduje boju svetlih delova;

Highlights Saturation - odreduje zasi¢enje bojom svetlih delova;

Shadows Hue - odreduje boju tamnih delova;

e Shadow Saturation - odreduje zasi¢enje bojom tamnih delova;

Balance - odreduje odnos jacine tamnih i svetlih delova slike.

5.21 IzoStravanje slike

Izostravanje slike je alat koji poveéava intenzitet boje linija vecée razlike u kontrastu. Pokreée se klikom na

Sharpen na traci sa alatima i na levoj strani se pojavljuju podesavanja:

e Amount - odreduje ja¢inu izo§travanja povecavajuéi kontrast oko linija;

Radius - odreduje kojem delu oko linija ¢e se povecéati kontrast;

Mask - odreduje koji deo tektura ¢e biti izoStren;

e Detail - smanjuje svetlost oko linija koja je formirana izoStravanjem;

Tresholhd - odreduje razliku u kontrastu da bi linija bila detektovana za izoStravanje.

5.22 Zamagljenje slike

Zamagljenje slike stvara efekat zamucenja pri udaljenost, kretanju, pri zaledivanju, oko centra i pri zumiranju.

Pokrece se klikom na Blur na traci sa alatima i pojavljuju se podeSavanja:
e Blur type - odreduje nacin zamagljivanja;

e Amount - odreduje ja¢inu zamagljivanja.

5.23 Uklanjanje $Suma na slici

Sum na slici je verijacija boje i osvetljenja slike kod nekog broja piksela. Na digitalnim fotografijama je
obi¢no vise vidljiv na tamnijim delovima slike. Uklanjanje razlike u nijansama piksela na slici gde bi trebalo da
bude ¢ista boja se vrsi alatom koji se pokrece klikom na Noise na traci sa alatima. PodeSavanja za ovaj alat

su:

e Despeckle - uklanja Sum na slici;
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e Square - uklanja Sum koriste¢i kvadrat veli¢ine 3x3 piksela;

X - uklanja Sum koristeéi oblik X veli¢ine 3x3 piksela;

e Plus - uklanja Sum koristeci oblik + veli¢ine 3x3 piksela;

Hibryd - uklanja Sum sa slika slikanim digitalnim fotoaparatom.

5.24 PodeSavanje jasnoce slike

Podesavanjem kontrasta izmedu srednjih tonova menja se i jasnoca slike, dok se svetli i tamni tonovi menjaju
vrlo malo. Alat koji povecava jasnoé¢u pokrece se klikom na Clarity na traci sa alatima i sa leve strane se

podesava:

e Strength - odreduje jacinu kontrasta.

5.25 Cetkica za detalje

Da bi se istakao jedan deo slike ili zamaglio i neutralisao drugi deo koristi se alat Cetkica za detalje. Uz
pomo¢ ovog alata moze povcéati kontrast jednog dela ili smanjiti kontrast i dodati efekat zamuéenosti. Klikom na

Detailed Brush pokrece se alat, koriste¢i Cetkicu (krug na slici) dodaje se efekat, koji je podesen paramterima:
e Operation - izbor izmedu zamagljivanja i izo§travanja slike;
e Nib Width - veli¢ina oblasti koju Zelimo da promenimo, tj. manjeg kruga;
e Feathering - veli¢ina prelaznog dela, tj. veceg kruga;

e Strength - ja¢ina primenjenog efekta, tj. zamagljivanja ili izoStravanja.
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6 Program Adobe Photoshop

6.1 O programu

Adobe Photoshop je najpopularniji program za kreiranje obradu slika. U odnosu na prethodne programe,
fotoSop je program za Sirokim spektrom alata za obradu slika, od osnovnih, o kojima je ve¢ bilo re¢, do kompli-
kovanih alata za kombinacije vige slika, dodavanje raznih efekata i boja. Za pocetnike, snalaZenje u programu
je izuzetno tesko i potrebno je dosta vremena da bi se savladali svi alati koje program sadrzi. Iz tog razolga
ovde ¢e biti predstavljeno samo nekoliko osnovnih primera.

Program se pokreée klikom na Start > Svi programi > Adobe Photoshop.

6.2 Primer 1: Spajanje boja dve slike

Prvo je potrebno da se otvore dve datoteke sa slikama, jednu kod koje se menja boja, a drugu ¢ija ¢e boja
uticati na prvu. To se radi klikom na File > Open. Moguce je otvoriti dve datoteke istovremeno, ako su obe
oznacene. Iznad slike su kartice preko kojih moze da se prelazi sa pregleda jedne na drugu sliku.

Kad je aktivna slika kojoj se menja boja, klikom na Image > Adjustment > Match Color otvorice se

novi prozor. U polju Source izabere se druga slika. Pomocu klizata podesimo Zeljeno osvetljenje i intenzitet

boje. Za vise podesavanja, videti [6].

Slika 21: Uticaj boje jedne slike na boju druge slike

6.3 Primer 2: Dodavanje delova jedne slike na drugu

Potrebno je otvoriti dve datoteke sa slikama, jedna sa koje se odseca deo slike i druga na koju se taj deo
dodaje. Kartice koje sluze za promenu sa jedne na drugu sliku, mogude je prevlacenjem na sredinu prozora,
izdvojiti tako da obe slike istovremeno budu vidljive. Na taj nacin je lak3e prebacivati delove jedne slike na
drugu.

Da bi se deo slike kopirao, prvo mora da se oznaci deo koji se kopira. Na levoj strani prozora se nalaze trake

sa alatima. Druga, treca i Cetvrta ikonica su alati koji mogu da se koriste za oznacavanje odredenog dela. U
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ovom slucaju, alat koji je najlaksi za koriséenje je Quick Selection Tool. Klikom na ¢etvrtu ikonicu, bira se
i aktivira ovaj alat. Iznad mesta gde su bile kartice, a ispod glavnog menija se nalaze podeSavanja za ovaj alat.
Ikonica sa plusom znaci da na deo slike koji je oznacen, dodajemo deo koji se obelezava. Ikonica sa minusom
oznacava da se od selektovanog dela oduzima deo koji se obelezava. Na taj nacin, se oznaéi deo slike koji se
prebacuje.

Kada je to uradeno, klikom na prvu ikonicu sa leve strane aktivira se alat za pomeranje i oznacen deo
prevucemo na drugu sliku. Menjanje veli¢ine dela koji je prebacen je moguce pritiskom tastera CTRL i t
istovremeno da bi se selektovao iskopirani deo, pa zatim moze da se promeni veli¢ina, polozaj i rotacija slike.
Da bi podesavanja bila potvrdena potrebno je pritisnuti ENTER na tastaturi.

Sa desne strane u kartici Layers postoje dva dela, tj. sloja. Da bi se promenile neke od karakteristika

potrebno je oznaciti taj sloj i onda bi podeSavanja bila moguca.

Slika 22: Dodavangje delova jedne slike na drugu
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7 Testiranje znanja ucenika na razli¢ito predstavljanje gradiva

Testiranje je izvrSeno na tri odeljenja Sestog razreda, pri ¢emu su odeljenja sli¢nih moguénosti, imaju priblizan
broj u¢enika i samim tim jednake uslove za rad. Testiranje je radeno za vreme Casa informatike u istoj u¢ionici.
tj. istim uslovima. Test se sastojao da se svakom odeljenju na razli¢it nacin predstavi isto gradivo odredi
uspesnost reSavanja zadatka u odnosu na taj nacin predstavljanja.

Ucenici su dobili zadatak da jednu sliku obrade u programu Microsoft Picture Manager i predstave je na

Cetiri nacina:
e da naprave crno-belu sliku,
e odsecanjem da dobiju deo slike,
e da je rotiraju za odreden ugao,
e da promene dimenzije slike.

Prva grupa je dobila sliku koju je trebalo obraditi i tekst sa uputstvima za program koja su data u poglavlju

Druga grupa je, takode, dobila sliku za obradu i tekst bez naglasenih (podebljanih) delova, podele po
funkcijama i lista sa podeSavanjima za svaku funkciju, nego su opcije svake funkcije bile navedene, jedna za
drugom, u jednom pasusu.

Treca grupa je imala isti zadatak i podatke kao i prva grupa, ali su imali i pomo¢ nastavnika, koji je davao
dodatne instrukcije i objasnjenja.

Ocekivano, trec¢a grupa je imala ubedljivo najbolje rezultate, tj. najbrze je uradila zadatak. Svaki ucenik
trece grupe brze je resio zadatak nego najbrzi ucenik druge grupe. Takode, ocekivano, prva grupa je imala bolje
rezultate nego druga grupa.

Pored ovih grupa, testiranje je izvrSeno i na ucenicima drugih razreda i na drugom gradivu i rezultati su bili

isti u svim testiranjima.
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8 Zakljucak

Covek je vizuelno bice. Preko sto miliona slika se svaki dan pojavi na internetu. Slike se pojavljuju u svim
oblastima, od arhitekture i gradevinarstva do medicine. Skoro svaka profesija koristi vizuelni prikaz u redovnim
aktivnostima. Svaka osoba se svakodnevno srece sa velikim brojem slika.

Napretkom tehnologije, poveéava se i potreba za programima sa veéim brojem alata za obradu. Programi
koji imaju skromne moguénosti mogu se koristi, ali ne mogu odgovoriti zahtevima koji su sve veéi. Uslovi rada
u Skolama se poboljsavaju, ali pojavom zahtevnijih programa, i ra¢unara sa boljim karakteristikama, javlja se
potreba za konstantnim ulaganjem.

Sa druge strane, napretkom tehnologije, pojavila se potreba za informatickom pismenoséu, a veliki deo
obuhvata znanje vezano za kreiranje i obradu slika. Samim tim znacaj predmeta Informatika i ra¢unarstvo u
osnovnoj skoli raste. Korelacija ovog predmeta je moguéa sa svim ostalim predmetima u nastavi osnovne skole.
Uz to, dolazi do moguénosti ucenja uz pomo¢ racunara, ali i njegove upotrebe u obradi nastavnih sadrzaja. Da
bi se olaksalo prenoSenje znanja koriste se sve vizualne moguénosti koje racunar poseduje, a njihov broj je sve
veéi. Osposobljavanje ucenika da se bave obradom slika, motivisalo bi ucenike da uc¢e na drugi nacin, a tokom
vremena bi donelo i neke nove nacine ucenja, predstavljanja i povezivanja gradiva.

Kroz rad se vide moguénosti koje poseduju jednostavniji i slozeniji programi za obradu slika, broj alata i na-
¢ini primene. Nastavnim planom i programom za Sesti razred iz predmeta Informatika i ra¢unarstvo predvidena
je obrada malog dela ovih alata. Povecanje broja ¢asova na kojima se obraduje ova oblast i pove¢anjem broja
programa za obradu slika i funkcija koje se koriste, predstavljalo bi znac¢ajan napredak u nastavi informatike i
racunarstva.

Moguénosti ucenika su velike. Zato je vrlo vazno usmeriti njihovo interesovanje na pravu stranu. Kao §to
se zakljucuje iz poglavlja 6, najveéi uticaj na to imaju nastavnici. Kvalitetan nacin predstavljanja gradiva i
prenoSenja gradiva je od kljuéne vaznosti. Iz tog razloga je vrlo vazno obuciti nastavnike za rad sa thenologijom
i programima koji napreduju i menjaju se vrlo ¢esto. Ulaganje u seminare, predavanja i obu¢avanje nastavnika,
podiglo bi nivo nastave informatike i ra¢unarstva na visi nivo i svakako unapredio Skolstvo.

Svakodnevno koriséenje i pregledanje velikog broja slika, njihova uloga u razvoju i upotreba pri savladavanju
novih vestina i prihvatanju novih znanja, navodi na zakljucak da je ulaganje u predmet Informatika i ra¢unarstvo,
u izmenu nastavnih planova i programa, poboljSanje uslova rada u 8kolama, kako hardverskih, tako i softverskih
sadrzaja i obuCavanje nastavnog kadra za rad, predstavlja ulaganje u buduénost. A posto su ljudi vizuelne

osobe, slike i programi za obradu slika, predstavljaju srediste takvog ulaganja.
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